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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 6.1.0 (part number (PNR) 609-004-000-051). 

This document contains information about changes to the software since the previously released version 
(VibroSight 6.0.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-221A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-229A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 
        (document reference 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 
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• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 
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• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the software 

modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic,  Protect, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600 card(s) – to refer to VibroSight compatible cards that are installed in a VM600 rack (that is, the first 
generation of VM600 systems). 

The currently available VM600 cards that are designed for operation with the VibroSight software are the 
XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is used for the configuration of VM600 cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, the RLC16Mk2 relay module and the 
CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 6.1.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 6.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection system 

VibroSight 6.1.0 adds further support for VM600Mk2 rack-based machinery protection and condition monitoring 
sytems for machinery protection applications, including: 

• For MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module – support for tachometer 
(tacho) signal sharing. 

• For CPUMMk2 + IOCNMk2 rack controller and communications interface module – official launch of this new 
module with new firmware and VibroSight software support. 

 

VM600Mk2 hardware 

The Meggitt vibro-meter® VM600Mk2 rack-based monitoring system is the evolution of the original VM600 
(VM600Mk1) solution for the protection and monitoring of rotating machinery used in the power generation and oil & 
gas industries. VM600Mk2 solutions are recommended when a centralised monitoring system with a medium to 
large number of measurement points (channels) is required. VM600Mk2 is typically used for the monitoring and/or 
protection of larger machinery such as gas, steam and hydro turbines, and generators, smaller machines such as 
compressors, fans, motors, pumps and propellers, as well as balance-of- plant (BOP) equipment. 

VM600Mk2 systems use existing VM600 rack infrastructure (racks and power supplies) with a new set of VM600Mk2 
modules: 

• VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module 

• VM600Mk2 RLC16Mk2 relay module 

• VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module. 
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These VM600Mk2 modules use the latest technology to offer improved performance compared to the existing 
MPC4 / IOC4T machinery protection card pair, RLC16 card, and CPUx / IOCx rack controller and communications 
interface card pairs. 

 

VM600Mk2 software 

The VibroSight software includes significant updates to all of its software modules (VibroSight Server and 
VibroSight client application modules (System Manager, Vision, etc.)) in order to support the new VM600Mk2 system 
and modules. 

Significantly, VibroSight 6.0.0 now includes VibroSight Protect, a new VibroSight client application dedicated to the 
configuration and operation of VM600Mk2 systems, that is, MPC4Mk2 + IOC4Mk2 modules, RLC16Mk2 modules and 
CPUMMk2 + IOCNMk2 rack controller and communications interface modules for machinery protection applications. 

NOTE: VibroSight Protect is distinct and separate from VibroSight Configurator in order to 
ensure the segregation of VM600Mk2 machinery protection systems (MPSs) and 
other systems such as condition monitoring systems (CMSs) when both are 
installed in the same VM600 rack (for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate 
configuration files. So it is simply not possible for access and/or changes to a CMS 
(VibroSight Configurator) to interfere in the operation of a MPS (VibroSight Protect) 
in the same VM600 rack, whether by accident or intent. 

(For reference, VM600Mk1 machinery protection systems (MPSs) are configurated 
and operated using the VM600 MPSx software.) 

 

The other existing VibroSight software modules are used for the operation and management of VM600Mk2 modules 
in the usual manner. For example, VibroSight Vision is used to display measurements from MPC4Mk2 + IOC4Mk2 
modules, while VibroSight System Manager is used to configure module Ethernet ports (IP addresses, etc.), update 
firmware, download log files, and so on. 

 

VibroSight Protect and VM600Mk2 systems 

VibroSight Protect is the new VibroSight software module, featuring a modern and ultra-clear user-interface, 
designed for the configuration and operation of VM600Mk2 systems for machinery protection. 

VibroSight Protect allows for the configuration of complete VM600Mk2 systems, consisting of: 

• VM600Mk2 racks – 6U (ABE04x system racks) and 1U (ABE056 slimline racks) 

• VM600Mk2 MPC4Mk2 + IOC4Mk2 modules 

• RLC16Mk2 modules 

• CPUMMk2 + IOCNMk2 rack controller and communications interface modules. 
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With VibroSight Protect, the signal list (Excel file) typically required by a VM600Mk1 system is no longer needed. A 
VM600Mk2 system configuration can now be created directly by an end-user and then used by Meggitt to build the 
system (as a VibroSight Protect configuration file contains all of the required information). 

NOTE: VibroSight Protect is completely separate and distinct to VibroSight Configurator 
(and VibroSight Capture) in order to ensure the complete separation 
(“segregation”) of machinery protection and condition monitoring in a VM600Mk2 
system. 

 

 

2.1.1 VM600Mk2 MPC4Mk2 + IOC4Mk2 modules – support for tachometer (tacho) signal sharing 

VibroSight 6.1.0 adds support for tachometer (tacho) signal sharing between MPC4Mk2 + IOC4Mk2 modules in a 
VM600 rack whereby a tacho (speed) signal configured for one MPC4Mk2 + IOC4Mk2 module can be shared as a 
reference signal for use by one or more other modules in the same rack. 

With tacho signal sharing, only a single tacho (speed) sensor / measurement chain needs to be installed, wired and 
configured for each reference tacho (speed) required by a VM600 rack. This can help to reduce costs and human 
errors, while also increasing reliability. 

NOTE: The VM600 rack backplane includes a Tacho bus that is intended for the transfer of 
speed signals between modules/cards in the rack. The Tacho bus consists of eight 
lines that are common to all slots in the rack, although only six lines are user 
configurable as tacho signals (two are reserved for system use). 
Refer to a VM600 machinery protection system (MPS) hardware manual for 
further information. 

 

In order to use tacho signal sharing with MPC4Mk2 + IOC4Mk2 modules in a VM600 rack: 

• A MPC4Mk2 + IOC4Mk2 module must be connected to the external tacho (speed) sensor / measurement chain, 
one of the module’s auxiliary channels must be configured to process the tacho (speed) signal and to put the 
signal onto the VM600 rack Tacho bus – this is a tacho signal source. 

• One or more MPC4Mk2 + IOC4Mk2 module auxiliary channel(s) must be configured to take the tacho (speed) 
signal being shared from the VM600 rack Tacho bus and to use it – these are tacho signal destination(s). 

 

As the VM600 rack’s Tacho bus is common to all slots in the rack, a tacho signal can be shared with all cards in a 
rack, no matter the rack slot number. (Note: Processing modules can be installed in rack slots 3 to 14, so there is a 
maximum of up to 12 × processing modules (cards) per rack.) 

As the VM600 rack’s Tacho bus has six user-configurable lines, up to 6 × different tacho signals can be shared in a 
rack. 

In a VM600 rack, each different tacho signal shared requires its own separate Tacho bus line, so it is important to 
keep track of which Tacho bus lines are used and where. This becomes particularly important in VM600 racks that 
combine MPC4Mk2 + IOC4Mk2 modules (configured using VibroSight Protect) and XMx16 / XIO16T cards (configured 
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using VibroSight Configurator) as it is possible for the same Tacho bus line to be inadvertently used in both 
configurations, which would result in a bus line conflict. 

 

 

For any (source) MPC4Mk2 + IOC4Mk2 module that will provide a tacho (speed) signal to be shared, the sensor / 
measurement chain must be connected (wired) to the appropriate screw-terminal connectors on the IOC4Mk2 and 
the appropriate auxiliary channel of the module must be configured with tachometer (speed) signal processing in 
order to process the sensor / measurement chain signal and generate the speed output, and to also put the signal 
onto the Tacho bus. 

Accordingly, in VibroSight Protect: 

1. Open an existing or create a new configuration. 

2. On the Layout tab/page, select or add the MPC4Mk2 + IOC4Mk2 module that will provide a tacho (speed) signal 
to be shared. 

3. On the Configure tab/page, select the MPC4Mk2 + IOC4Mk2 module that will provide a tacho (speed) signal to 
be shared and configure the auxiliary channel that is connected to the tacho (speed) sensor / measurement 
chain as usual. 

More specifically, under Channels (left), click the Auxiliary n channel and use the configuration dialog box that 
appears to select Single (Processing type), then Tachometers and Speed (Processing function). When 
prompted to select the Input signal, use the Library tab in order to select an existing sensor / measurement 
chain or use the Add control (bottom) to use a different sensor / measurement chain. Click Finish to continue. 

Then, on the General tab (centre), ensure that Sensor signal sharing to is configured to use one of the 
available Tacho bus lines: Tacho bus line 0, Tacho bus line 1, Tacho bus line 2, Tacho bus line 3, Tacho 
bus line 4 or Tacho bus line 5 to share the signal. 

Note: If tacho signal sharing is not being used for the auxiliary channel, then ensure that the default setting of 
Sensor signal sharing to: Disabled is used. 

 

Note that once configured, under Channels (left), the Auxiliary n channel updates to display summary information 
about its configuration. For example: 
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For any (destination) MPC4Mk2 + IOC4Mk2 module that will use a tacho (speed) signal being shared, an auxiliary 
channel of the module must be configured with tachometer (speed) signal processing in order to be able to take the 
signal from the Tacho bus. 

Accordingly, in VibroSight Protect: 

1. On the Layout tab/page, select or add the MPC4Mk2 + IOC4Mk2 module that will accept a tacho (speed) signal 
being shared. 

2. One the Configure tab/page, select the MPC4Mk2 + IOC4Mk2 module that will accept a tacho (speed) signal 
being shared and configure the auxiliary channel that is connected to the tacho (speed) sensor / measurement 
chain as usual. 

More specifically, under Channels (left), click the Auxiliary n channel and use the configuration dialog box that 
appears to select Single (Processing type), then Tachometers and Speed (Processing function). When 
prompted to select the Input signal, use the Existing signal input tab to select the MPC4Mk2 + IOC4Mk2 module 
auxiliary channel that provides the required tacho (speed) signal. Click Finish to continue. 

Note: Only auxiliary channels configured for tacho (speed) signal sharing enabled are listed on the Existing 
signal input tab. If no auxiliary channels have been configured to share a tacho signal 
(Sensor signal sharing to: Tacho bus line n )), then the Existing signal input tab will be empty. 

Note that on the General tab (centre), for a destination auxiliary channel configured to use the output from 
another auxiliary channel as an input for tacho signal sharing, the Sensor signal sharing to control is not 
provided and certain other controls such as Position, Pulses per revolution and Edge detection become 
unavailable (greyed out) because the destination auxiliary channel effectively inherits such settings from the 
source auxiliary channel (so it is not possible to configure them independently). 

 

Note that once configured, under Channels (left), the Auxiliary n channel updates to display summary information 
about its configuration. For an auxiliary channel that is configured to use the output from another auxiliary channel 
for tacho signal sharing, this summary information includes a special “linked” symbol: For example: 

 

 

 

After a (destination) MPC4Mk2 + IOC4Mk2 module that uses sensor signal sharing has had one of its auxiliary 
channels configured as described above, that auxiliary channel can then be used wherever and whenever a speed 
reference is required by the module, for example, the Reference speed used by a Bearing absolute vibration 
processing block. That is, the auxiliary channel will function in exactly the same way that an auxiliary channel 
connected to a “local” sensor / measurement chain functions. 
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When the Tacho bus is used for tacho signal sharing in this way, VibroSight Protect automatically updates the 
Bus view available in the Layout tab/page to show that the Tacho bus is used. This is shown in Figure 1. 

 

  
Figure 1: VibroSight Protect Layout tab/page – Bus view 

 

In the Bus view, the rack buses are shown as grey if unused or shown as blue if used. To display more detailed 
information on the configuration and usage of individual VM600 rack buses, click on the bus name (left of rack) on 
the Bus view in order to display an individual bus window, for example: 
Tacho bus 
6 lines. 

The individual bus windows for the Tacho bus, Raw bus and OC Bus n display detailed information on the 
configuration and usage of the individual VM600 rack bus. Initially, they show the default bus configuration as 
determined by VibroSight Protect for the application. They also allow the automatically assigned bus configuration 
to be changed, should this become necessary. 
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2.1.2 VM600Mk2 CPUMMk2 + IOCNMk2 modules – official launch of this new module with new 
firmware and VibroSight software support  

VibroSight 6.1.0 introduces full support for the VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications 
interface module. This includes a new officially released version of firmware for the module (see 2.4 CPUMMk2 + 
IOCNMk2 module) and updates to the VibroSight software in order to support the configuration and operation of the 
module. 

 

In general, for VM600Mk2 CPUMMk2 + IOCNMk2 modules (as per other VM600Mk2 modules): 

• VibroSight Protect is used for the configuration and operation of modules. 

• VibroSight System Manager is used for the operation and management of modules. 

 

 

VibroSight Protect user interface – Layout tab/page 

In VibroSight Protect, the Layout tab/page is used for the configuration and display of general information for the 
VM600Mk2 system. This is shown in Figure 2. 

Importantly, the Layout tab/page is used to add modules to a configuration for a VM600Mk2 system (and to remove 
the modules too). 

 

 
Figure 2: VibroSight Protect Layout tab/page 

(with a CPUMMk2 in slot 0) 
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System properties (left) is used to define information about the rack, including the specific type of rack. 

System I/O (left) provides summary information on the inputs, outputs and resources used by the rack. This is 
dynamically updated as modules are added to the rack and configured. 

Power consumption calculator (left) is used to define information about the power supply configuration used by the 
rack. This is dynamically updated as modules are added to the rack and configured, so that the user knows if the 
power supply configuration is suitable for the populated rack. 

Main window (centre) is used to add modules to the rack. Double-clicking a blank (empty) rack position/slot allows 
a new module to be selected for that position/slot. 

For example: 

CPUMMk2 modules can be added in position/slot 0 or 1 (front of rack). When a CPUMMk2 module is added, the 
associated IOCNMk2 module is automatically added in the corresponding position/slot in the rear of the rack. 

NOTE: VM600Mk2 systems support a single CPUMMk2 + IOCNMk2 module, so a 
configuration created in VibroSight Protecte can contain a maximum of 
1 × CPUMMk2 + IOCNMk2 module. 

 

MPC4Mk2 modules can be added in position/slot 3 to 14 (front of rack). When a MPC4Mk2 module is added, the 
associated IOC4Mk2 module is automatically added in the corresponding position/slot in the rear of the rack. 

RLC16Mk2 modules can be added in position/slot 1 to 14 (rear of rack). 

In the main window, the Rotate control (top right) is used to toggle the view of the rack between the front view or 
the rear view. 

In the main window, the Bus view control (top right) is used to toggle the view between the rack view or the rack 
buses view. 

 

The Bus view is shown in Figure 1. 

 

System (right) is used to remove modules from the rack. 

History (right) is used to undo or redo recent changes to the rack using the “–” icon (Remove item). 

 

Consistency check (bottom) is used to run and/or display consistency check information so that any problems in the 
VM600Mk2 system configuration can be corrected. The Consistency check title bar is displayed in purple if no 
problems ae detected but is displayed in red if problems are detected. 

Clicking on the Consistency check title bar expands or collapses the consistency check window, as required. 
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VibroSight Protect user interface – Configure tab/page 

The Configure tab/page is used for the configuration and display of general information for the modules in a 
VM600Mk2 system, including for a CPUMMk2 + IOCNMk2 module: This is shown in Figure 3. 

 

 
Figure 3: VibroSight Protect Configure tab/page 

(with a CPUMMk2 in slot 0) 

 

Main window (top) shows the bottom portion of the rack configured in the Layout tab/page.  

As in the Layout tab/page, the Rotate control (top right) is used to toggle the view of the rack between the front 
view or the rear view. 

 

When a VM600Mk2 module is selected in the rack (top) by clicking on it, the main features for the module are 
displayed in functional groups in the main window (left) and general information for the module is displayed in the 
main window (centre). 

For a VM600Mk2 CPUMMk2 + IOCNMk2 module, the main features are Fieldbuses. And the general information 
includes module Enabled, Name and Description and Network settings (IP address) on the General tab. 

For a VM600Mk2 MPC4Mk2 + IOC4Mk2 module, the main features are Channels, Logical functions, Relays and 
Analog outputs. And the general information includes module Enable, Name and Description, Network settings 
(IP address) and the Watch RLC16 relay status control on the General tab and the required jumper configuration 
on the Jumpers tab. 



 

Document reference VIBROSIGHT-RN/E (660-010-013-232A) 
Version 32A – 06.07.2021 

RELEASE NOTES 
VibroSight® 6.1.0 

19 / 71 
 

For a VM600Mk2 RLC16Mk2 module, the main features are Logical functions and Relays. And the general 
information includes module Enable, Name and Description on the General tab and the required jumper 
configuration on the Jumpers tab. 

When an item is selected from a functional group in the main window (left), the main window (centre) updates to 
display the information for the item, including all configurable parameters. 

 

For all VM600Mk2 modules 

To configure the network communication settings for any VM600Mk2 module, on the Configure tab/page, select the 
module (top), then in the main window (centre), on the General tab, under Network settings, use the Mode and 
other controls to determine how VibroSight Protect should find the IP address to be used for communication with 
the module: 

• With Mode: Automatic discovery from serial number, the module is automatically identified using the serial 
number that is entered manually in the Serial number text box. 

NOTE: The serial number of a VM600Mk2 module can be found by inspecting the labels 
(stickers) on the module hardware or by using VibroSight System Manager. 

 

The card’s IP address will then automatically be read by VibroSight Protect for use by the system and 
displayed in the IP address text box. 

NOTE: VibroSight uses a proprietary implementation of the zero-configuration networking 
(zeroconf) protocols in order to support networking operations such as the 
automatic discovery of VM600Mk2 modules. 
If the automatic discovery does not work (for example, due to a network not 
meeting the requirements of zeroconf), then connections between VibroSight-
system components can be established manually by entering the IP addresses of 
the network devices. 

 

• With Mode: Manual IP address, the module is identified using the IP address that is entered manually in the 
IP address text box (in which case, the Serial number is effectively ignored). 

NOTE: In VibroSight Protect, the IP address text box is used to display the IP address 
(Mode: Automatic discovery from serial number) or enter the IP address 
(Mode: Manual IP address) to be used for communication with a VM600Mk2 
module – but it cannot be used to change an IP address. 
VibroSight System Manager is used to change the IP address of VM600Mk2 
modules, as required by an application.  
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For CPUMMk2 + IOCNMk2 modules 

When the Fieldbus is selected for a CPUMMk2 module by clicking on it (Fieldbus 1, left), the information and 
parameters related to the fieldbus configuration are displayed in the main window (centre). 

For a CPUMMk2 module, the configuration of the fieldbus is currently defined by a fieldbus configuration file (*.cfg) 
that must be uploaded to VibroSight Protect using the Load from file … control (bottom, right of main window). 

NOTE: CPUMMk2 fieldbus configuration files are external files that are currently generated 
and edited manually using a text editor. 
In this sense, VM600Mk2 CPUMMk2 fieldbus configuration files (*.cfg) are similar to 
the VM600 CPUx Modbus configuration files (modbusDefault.cfg). 
Contact Meggitt SA for further information. 
In the future, VibroSight Protect will incorporate this functionality, allowing fieldbus 
configuration files to be generated and edited without the use of external tools.  

 

The information and parameters from the uploaded fieldbus configuration file are displayed in the main window 
(centre) in the Fieldbus configuraton text box. If no fieldbus configuration is uploaded (configured) for a CPUMMk2 
module, then the Fieldbus configuraton text will be blank (empty). 

 

For MPC4Mk2 + IOC4Mk2 modules 

When a Channel is selected for a MPC4Mk2 module by clicking on it (in a functional group, left) and the channel is 
not yet configured, a Configuration of a Channel window is displayed that guides the user through the configuration 
of the channel in terms of: 

• Processing type: single-channel or dual-channel. 

• Processing function (based on sensor family): For example, bearing absolute vibration or shaft relative 
vibration. 

• Input signal: From a library of sensors / measurement chains. 
Note: The default Library can be expanded by editing sensors / measurement chains and/or adding new ones 
(vibro-meter® or third-party), as required. 

• When a Channel is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking on it and the channel is 
already configured, the information for the channel is displayed in a series of tabs (General, Processing, 
Alarms). 

Once the Channel is configured, the information for the channel is displayed in a series of tabs (General, 
Processing, Alarms). 

Similarly, when a Channel is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking on it (in a functional 
group, left) and the channel is already configured, the information for the channel is displayed in a series of tabs 
(General, Processing, Alarms). 

For each Channel, the General, Processing and Alarms tabs must be edited in the main window (centre) to 
configure the parameters and functionality for the channel, as required by the application. 
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When a Logical function, Relay or Analog output is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking 
on it (in a functional group, left), the information and parameters for the feature are displayed in the main window 
(centre), where they must be edited, as required by the application. 

 

For RLC16Mk2 modules 

When a Logical function or Relay is selected for a VM600Mk2 RLC16Mk2 module by clicking on it (in a functional 
group, left), the information and parameters for the feature are displayed in the main window (centre), where they 
must be edited, as required by the application. 

 

As in the Layout tab/page, System (right) is used to remove modules from the rack, History (right) is used to undo 
or redo recent changes to the rack using the “–” icon (Remove item) and Consistency check (bottom) is used to run 
and/or display consistency check information so that any problems in the VM600Mk2 system configuration can be 
corrected. 

 

 

Activating a configuration on a VM600Mk2 system 

As the configuration for a VM600Mk2 system is being developed, the Consistency Check window (bottom) should be 
used to help correct any configuration errors and warnings as they occur, thereby helping ensure that a valid 
configuration is arrived at. 

Once a configuration has been created and/or changed, and there are no consistency check errors, the 
configuration must be uploaded to the VM600Mk2 system in order to actually run on the system hardware (VM600 
rack containing VM600Mk2 modules). 

The Tools > System activation command is used to upload the complete VM600Mk2 system configuration 
currently active/loaded in VibroSight Protect to the system hardware. 

As part of the system activation process, VibroSight Protect will upload each individual VM600Mk2 module in turn 
with its part of the complete VM600Mk2 system configuration, then read back each individual module configuration in 
order to check it against the complete VM600Mk2 system configuration again, thereby ensuring that the 
configuration was uploaded to each individual module correctly. 

Once this check is complete, VibroSight Protect will prompt the user to continue (Proceed). This is shown in 
Figure 4. 
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Figure 4: VibroSight Protect System activation window – upload and check 

 

 

After the user has clicked Proceed, VibroSight Protect will: 

• Archive the running configuration 
(in case it needs to be reverted to should something go wrong with the activation of the configuration). 

• Activate the current configuration. 

• Run (go “live”) with the new configuration – Success! 

This is shown in Figure 5. 
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Figure 5: VibroSight Protect System activation window – activation 
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Please note that when activating a configuration on a VM600Mk2 system: 

• All of the modules contained in the configuration must be available at the same time. More specifically, all 
MPC4Mk2 modules must be connected to and available on the same network as the computer running 
VibroSight Protect. This is typically done using a network switch. 

• When a configuration is uploaded to a VM600 rack, MPC4Mk2 modules will restart after receiving the 
configuration in order to enter their Power-up mode and perform a power-on self-test (POST), thereby helping 
to ensure that the configuration is correct and valid. 
Note: A MPC4Mk2 module takes approximately 20 seconds to boot and complete its power-on self-test (POST). 

• After successfully booting, a MPC4Mk2 module will revert to its Operational mode – in either the Locked state 
(safety/secure operating mode) or Unocked state (maintenance operating mode), depending on the 
Operational mode state it was in before restarting (rebooting). 

 

 

VibroSight Protect user interface – Dashboard tab/page 

The Dashboard tab/page is used to operate and manage the VM600Mk2 system, that is, a system that I srunning a 
configuration. This is shown in Figure 6 (for a CPUMMk2) and Figure 8 (for a MPC4Mk2). 

 

  
Figure 6: VibroSight Dashboard Layout tab/page 

(CPUMMk2 in slot 0) 

 

Please note that for CPUMMk2 + IOCNMk2 modules, there is no functionality available from the Dashboard tab/page. 
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Figure 7: VibroSight Dashboard Layout tab/page 

 

Please note that for MPC4Mk2 + IOC4Mk2 modules, there is functionality available from the Dashboard tab/page. 

This includes measurement information, control inputs and status information such as: 

• Channel sensor OK check, measurement data values and data quality information. 

• Module status (Operating mode: Running or Recovery, Lock state: Locked or Unlocked) information. 

• Alarm controls: Trip multiply (TM), individual channel bypasses and Alarm reset (AR). 

• Relays status information. 
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VibroSight System Manager and VM600Mk2 systems 

For VM600Mk2 systems, VibroSight System Manager is used to display information about VM600Mk2 modules. 

 

In the System Explorer window (left), CPUMMk2 + IOCNMk2 modules are listed under CPUM modules and 
CPUMMk2 + IOCNMk2 modules are listed under MPC4  modules. 

 

In general, for VM600Mk2 modules in VibroSight System Manager, functionality is available from the Actions window 
(right) and general information is displayed in the main window (centre). However, for CPUMMk2 + IOCNMk2 modules 
in VibroSight System Manager, while functionality is available from the Actions window (right), no general 
information is displayed in the main window (centre). 

 

For example, as shown in shown in Figure 8 (centre), under General Information, this includes the Operating mode, 
which for MPC4Mk2 modules can be one of 4 modes: 

• Power-up 

• Operational 

• Fail-safe 

• Recovery. 

 

Further, the Operational mode can be in one of 2 states: 

• Locked (safety/secure operating mode) 
The VM600Mk2 system performs its monitoring and protection functions while ensuring the security of the 
modules/system and it’s configuration. That is, the configuration cannot be changed and maintenance activities 
cannot be performed. 

• Unlocked (maintenance operating mode) 
The VM600Mk2 system performs its monitoring and protection functions without ensuring the security of the 
modules/system and it’s configuration. That is, the configuration can be changed and maintenance activities 
can be performed. 

NOTE: Physical access to a VM600Mk2 system (specifically, the buttons on the front panel 
of VM600Mk2 module) is required in order to change the operating mode and 
therefore to be able to change the machinery protection (MPS) functionality for a 
VM600Mk2 system. 

 

The Lock state is shown under Diagnostics (see Figure 8), as are the firmware versions available on the module 
(under Firmware versions). 
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Figure 8: VibroSight System Manager information and actions for a MPC4Mk2 module 

 

Figure 8 (right) also shows the various actions/tasks that VibroSight System Manager can perform for MPC4Mk2 
modules, notably: 

• Maintenance: Changing firmware, LED test and module identification. 

• Configuration: Configuration of IP and NTP settings. 

• Diagnostics: Download of diagnostics log. 
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2.2 Polar plot cursor synchronisation 

In VibroSight Vision, the Polar plot has been updated so that its trend subplots now implement cursor 
synchronisation as a function of whichever quantity (Speed or Time) is selected for the x-axis of the trend subplots 
(Trends). 

(For reference, Polar plot trend subplots previously implemented cursor synchronisation as a function of phase.) 

With this improvement, it is now easier to use Polar plots to compare and analyse data from different transients. It 
also means that the Polar plot is now using the same cursor synchronization as other VibroSight Vision plot types, 
notably the Bode plot. As a result, VibroSight more consistent and easier than ever to use for data analysis, 
especially when using cursor synchronization across multiple different plots and/or plot types. 

NOTE: Cursor synchronisation is intended to be used to help quickly find corresponding 
information in other measurements after particular data of interest is found in one 
plot. This allows all of the information relevant to a particular event or time period 
be more easily displayed and analysed together in more detail, for example, by 
using different plots, different types of plot, different measurement points and so 
on. 

 

 

VM600Mk2 modules 

2.3 MPC4Mk2 + IOC4Mk2 module 

Updated MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module operational firmware 
(640-025-004-000.Mpc4g2Fw) with the following main improvements: 

• New features: 

o For frequency domain measurements (Amplitude + Phase (Vector)), the phase component of the 
measurement can now be used as the input signal for an Analog output. 

o For Differential expansion (dual taper) processing, the ramp angles for the taper on the shaft are now 
configured separately (α1 and α2) in order to allow different ramp angles to be used for each side of the 
shaft taper. 

o For auxiliary input channels configured as tachometer (tacho) inputs, should the input tacho signal go 
outside of the specified speed / frequency measurement range, the system will now respond with 
appropriate data quality indicators and warning messages, and recover automatically (that is, resume 
normal operation) when the tacho returns to normal. 
(Previously, the system responded by entering the fail-safe operating mode, thereby triggering the 
VM600Mk2 system safety-line, that is, the system-wide control signal that automatically drives all system 
relays (IOC4 Mk2 and RLC16 Mk2) and analog outputs (IOC4 Mk2) to a safe state.) 

o The maximum tachometer (tacho) speed / frequency has been increased to 51200 Hz (from 3200 Hz). 
Note: This enables solutions for higher-speed applications such as steam turbines. 
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• Solved problems and bug fixes: 

o Sensor / channel bypass for channel 3 not working as expected in response to either the 
Channel 3 bypass control (VibroSight Protect Dashboard tab/page, under Alarm controls) or in 
response to an auxiliary channel configured as a tacho used as the Reference speed for channel 3 
being bypassed. 

o General improvements to logical functions. 

 
In addition, the MPC4Mk2 + IOC4Mk2 module recovery firmware (640-031-003-004.Mpc4g2Fw) was also updated, 
while the proof test firmware (640-032-001-000.Mpc4g2Fw) is unchanged. 

See also 2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection system and 5.2 VM600 
cards. 

 

 

2.4 CPUMMk2 + IOCNMk2 module 

To support the launch of the new CPUMMk2 + IOCNMk2 rack controller and communications interface module, a new 
officially released version of firmware (base-system-640-034-001-000.tgz) is now available. 

NOTE: The CPUMMk2 + IOCNMk2 rack controller and communications interface module is 
now officially released. 
Any current “evaluation” versions of CPUMMk2 + IOCNMk2 module firmware must be 
upgraded to the latest officially released firmware – in order to use the system in 
“live” machinery protection system (MPS) applications. 
Contact Meggitt SA for further information. 

 

See also 2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection system and 5.2 VM600 
cards. 
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VibroSmart® modules 

2.5 VSV30x + VSB300 module 

Updated VSV30x + VSB300 monitoring module firmware (642-001-000-019.xtranfw) with the following main 
improvements: 

• New features: 

o Improved startup (boot) time of approximately 3.5 minutes, effectively halving the time required for the 
module to start and be operational. 

o Better use of the precision time protocol (PTP) to improve time synchronization precision (up to 1 ms) 
of measurement data from different VSV301 modules and VibroSight®. 

o New frequency domain extractions based on harmonics are available for measurements synchronous 
to the rotating speed, so that it is now possible to measure the energy over a band. For example, this 
allows measurements between 0.3X and 0.6X for oil effect monitoring in fluid bearings. 

o Position processing corrected so that it now has the same behaviour as the VM600 Mk2 MPC4Mk2 
(and VM600 MPC4). 

o Adaptive monitoring and Trip multiply (TM) corrected so that it now has the same behaviour as the 
VM600 Mk2 MPC4Mk2 (and VM600 MPC4). 

• Solved problems and bug fixes: 

o Low-frequency noise in FFT for Not 1X measurements. 

o Narrow-band vibration processing not working for input channels configured with AC + DC coupling. 

o General improvements to tacho ratio. 

See also 5.3 VibroSmart devices. 

 

 

2.6 VSI010 + VSB010 module 

Updated VSI010 + VSB010 communications interface module firmware (642-002-000-013.xmsifw). 

See also 5.3 VibroSmart devices. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 6.1.0 software. 

 

3.2 VibroSight data management’s offline data storage operations not adding the “_alarm” 
suffix to data files as expected 

VibroSight’s fully-integrated support for VibroSight database management simplifies the configuration and 
operation of the database backup, database purge and management of offline data storage. 

VibroSight data management’s “Offline data storage” operations are used to schedule the creation of regular 
periodic copies of the online database (data repository) used by a VibroSight Server. That is, online VibroSight 
historical data folder (*.vshdf) → multiple smaller offline VibroSight historical data archives (*.vshda). 

NOTE: Regular copies (offline data storage) are required in order to build up an offline 
historical record of the latest data from the data repository that can be referred to 
when analysing/diagnosing machinery. (In order to limit the size of the online data 
repository, offline data storage is used to copy older data before it is purged from 
the data repository.) Weekly or monthly copies are recommended as they are a 
good compromise between operating performance of the machinery monitoring 
system and file/data handling (VibroSight historical data archive file sizes). 

 

For Offline Data Storage operations that were configured with output file flagging enabled (VibroSight Configurator, 
(Data Storage view), Offline data storage operation, Output file flagging tab with Severities selected), the “_alarm” 
suffix was not always being automatically added to the output data files (offline archives (*.vshda)) as expected. 
More specifically, even if alarms (Alert and/or Danger) were selected as flaggable for the Offline data storage 
operation and alarms had occurred for the data being copied, the “_alarm” suffix could be missing from the offline 
archives (*.vshda)). 

 

3.3 Problem with missing data types using VibroSight OPC Classic HDA 

VibroSight data types which consist of both a value and a unit were not properly available from VibroSight OPC 
servers and therefore capable of being properly displayed and correctly processed by OPC client applications – as 
they were not directly mappable to an OPC data type. For example, “Frequency maximum” with a value of 
“1000 Hz”. 

Such VibroSight data types have now been made properly available by publishing them as measurements (OPC 
items) using different OPC item properties: one for the value and one for the unit. For example, 
“Frequency maximum value” and “Frequency maximum unit”. 

The modified OPC properties are Frequency maximum, Order maximum, Revolution duration and Time duration. 
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3.4 Problem displaying magnetic flux measurement data in polar waveform plots 

When using the Polar Waveform plot in VibroSight Vision to display Flux signature measurement data, in the 
Nominal column, the plot legend displayed the nominal gap value rather than the expected nominal flux value. 

 

3.5 Problem configuring a VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s analog output to use 
differential expansion (single taper) processing 

In VibroSight Protect, it was not possible to configure an Analog output for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module 
to use the measurement (output) from a Differential expansion (single taper) processing function as its input signal.  

 

3.6 Unexpectedly high CPU usage when configuring a VM600Mk2 1U system 

In VibroSight Protect, when configuring VM600Mk2 1U systems (that is, a VM600 slimline rack (ABE056) containing 
a VM600Mk2 MPC4Mk2 + IOC4Mk2 module), the CPU usage for the computer running VibroSight Protect could 
become and remain expectedly high (for example, 30%). 

 

3.7 VibroSight OPC UA server stops working 

Under certain circumstances, the OPC UA (unified architecture) server of a VibroSight Server could stop working 
(“freeze”) after having operated successfully for hours. 

 

3.8 Problem changing data sources for a VibroSight Mimic 

In VibroSight Mimic, a Mimic project using a VibroSight Server as the data source could stop correctly displaying 
data when the data source was changed to a different equivalent VibroSight Server. More specifically, the 
VibroSight Mimic could stop updating data. 

 

3.9 Problem operating a VibroSmart® system containing VSV30x monitoring modules, a VSI010 
communications interface module and a Modbus server 

For a VibroSmart® system containing VSV30x + VSB300 monitoring modules, a VSI010 + VSB010 
communications interface module and a Modbus server (that is, a network Modbus device configured as a Modbus 
slave) all as part of a single VibroSight Server configuration, the resultant VibroSight Server experienced a problem 
when the configuration was activated on the server. 

The behaviour of such a VibroSmart® system was typically characterised by the VSI010 module providing incorrect 
data values (for example, incorrect amplitude – orders of magnitude too large) and the VibroSight Server reporting 
messages on the Log messages tab such as: 

• “[Warn] VibroSmart Module Driver: Current configuration set on the module (VSCxxxxxx) does not match the 
server’s one.” 

• “[Error] VibroSmart Module Driver: The acquisition will not be started for the module ‘VibroSmart VSI010 
Module x’ because the configuration on the server is different from the one on the module.” 
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3.10 VibroSight software licence containing Modbus tags not correctly recognised 

In VibroSight System Manager, when activating/installing a new licence key file for a VibroSight software licence 
(specifically, the Trend software edition with 100 Modbus client tags), VibroSight System Manager did not correctly 
recognise and activate the licensed Modbus functionality, instead reporting the problem on the Licensing 
information tab: “A license exists for Modbus package but the associated product is not installed.“ 

 

3.11 Problem operating a VibroSmart® system containing a VSV30x monitoring module using 
adaptive monitoring 

For a VibroSmart® system containing a VSV30x + VSB300 monitoring module using adaptive monitoring (that is, a 
measurement (extracted data entity) with 1D fixed limit – adaptive monitoring) with an adaptive monitoring 
coefficient value less than 1.0, the resultant VibroSight Server experienced a problem when the configuration was 
activated on the server. 

The behaviour of such a VibroSmart® system was typically characterised by the VSV30x module not being 
configured and the VibroSight Server reporting messages on the Log messages tab such as: 

• “[Error] VibroSmart Module Driver: Module VSCxxxxxx. Configuration validation failed. The’Coefficient’ attribute 
is invalid - The value ‘0.9’ is invalid according to its datatype ‘Decimal’ - The MinInclusive constraint failed.” 

•  “[Error] VibroSmart Module Driver: Error running driver for module VSCxxxxxx. Module configuration validation 
failed.” 

•  “[Info] VibroSmart Module Driver: Disconnection from module VSCxxxxxx. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

 

4.2 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 
 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 
 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 

 
 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 
 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 
 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 
 

4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 
This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 
 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 
 

4.11 Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 
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• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 
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4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully installed and run. 

 

 

4.13 Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 

 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

4.14 Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

  

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

5.1 VibroSight software 

VibroSight 6.1.0 is a minor level release and replaces VibroSight 6.0.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 6.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 6.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 6.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 6.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 6.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
5.1.1 Microsoft Windows operating systems 
VibroSight 6.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 6.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 6.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 6.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 6.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 6.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 6.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 6.x.x (VibroSight 3.x.x or later) is described in detail in the “Data 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600 cards 

5.2.1 Card firmware 

There are some firmware upgrades for VM600 cards corresponding to VibroSight 6.1.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Operational: 640-025-004-000.Mpc4g2Fw 

• Recovery: 640-031-003-004.Mpc4g2Fw 

• Proof test: 640-032-001-000.VxeFw (unchanged) 

See 2.3 MPC4Mk2 + IOC4Mk2 module. 

 

The latest firmware for the new VM600Mk2 CPUMMk2 module is now: 

• Base system: base-system-640-034-001-000.tgz 

See 2.4 CPUMMk2 + IOCNMk2 module. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Base System: base-system-640-014-001-003.tgz 

• Applications: applications-640-015-001-003.tgz 

 

The latest firmware for the VM600 CPUR card remains: 

• Base System: base-system-640-011-001-005.tgz 

• Applications: applications-640-012-001-005.tgz 

 

NOTE: In order to help distinguish between VM600Mk2 CPUx modules and VM600 CPUx 
cards, VibroSight 6.0.0 and later uses the following terminology: 
• CPUMMk2 to refer to the VM600Mk2 CPUx module with mathematical processing of 
fieldbus data and support for Modbus TCP and PROFIBUS DP (PNR 600-050). 
• CPUR2 to refer to the latest version of the VM600 CPUx card with support for 
PROFIBUS (PNR 600-026-000-VVV). 
• CPUR to refer to the earlier version of the VM600 CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 
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The latest firmware for the VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Base System: base-system-640-003-001-016.tgz 

• Applications: applications-640-010-001-016.tgz 

 

Therefore, for current versions of VibroSight / VM600Mk2 systems, firmware upgrades are required. 

See also VM600Mk2 modules. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are some firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 6.1.0. 

 

The latest firmware for the VSI010 module is now: 

• 642-002-000-013.xmsifw  

See 2.6 VSI010 + VSB010 module. 

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-011.redboxfw  

 

The latest firmware for the VSV30x module is now: 

• 642-001-000-019.xtranfw  

See 2.5 VSV30x + VSB300 module. 

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are required. 

See also VibroSmart® modules. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 6.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and VibroSmart 
devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to take advantage of 
improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used unintentionally or 
incorrectly, lead to malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the VibroSight software 
installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their .tgz file name 
extension. For example, the XMV16 subfolder contains the applications and base system firmware for use by 
XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored in these 
directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 5 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 

 

 

 

  



 

Document reference VIBROSIGHT-RN/E (660-010-013-232A) 
Version 32A – 06.07.2021 

RELEASE NOTES 
VibroSight® 6.1.0 

51 / 71 
 

Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software version 

Part number (PNR) 

Operational (640-025-vvv-ppp.Mpc4g2Fw) 

640-025-001-000 640-025-002-000 640-025-003-002 640-025-004-000 

Recovery (640-031-vvv-ppp.Mpc4g2Fw) 

--- --- 640-031-003-002 640-031-003-004 

Proof test (640-032-vvv-ppp.VxeFw) 

--- --- 640-032-001-000 

5.0.0 
609-004-000-048 

 See note 1   
 

5.1.0 
609-004-000-049 

  See note 2  
 

6.0.0 
609-004-000-050 

   See note 3  

6.1.0 
609-004-000-051 

    See note 4 

 

Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is a release intended to support the development 
and evaluation of VibroSight Protect and VM600Mk2 systems only. 
 

2. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is a release intended to support the ongoing 
development and evaluation of VibroSight Protect and VM600Mk2 systems only. A firmware upgrade is required in order to run VibroSight 5.1.0 
or later. 
 

3. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – and in order to use the 
system in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

4. For information on this version of VM600Mk2 MPC4Mk2 firmware, see 2.3 MPC4Mk2 + IOC4Mk2 module. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
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Table 2: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system (*.tgz) 

640-034-001-000 

6.1.0 
609-004-000-051 

 See note 2 

 

Notes for Table 2 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-034-001-xxx for 
the base system firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUMMk2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-034-000-xxx 
for the base system firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.4 CPUMMk2 + IOCNMk2 module. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
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Table 3: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 640-014-001-003 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 640-015-001-003 

3.4.0 
609-004-000-041 

 See note 2  See note 3  

3.5.0 
609-004-000-042 

   

3.6.0 
609-004-000-043 

   

3.7.0 
609-004-000-044 

   

3.8.0 
609-004-000-045 

   

4.0.0 
609-004-000-046 

   

4.1.0 
609-004-000-047 

   See note 4 

5.0.0 
609-004-000-048 

   

5.1.0 
609-004-000-049 

   

6.0.0 
609-004-000-050 

   

6.1.0 
609-004-000-051 

   

 

 

Notes for Table 3 (see the next page)  
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Notes for Table 3 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
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Table 4: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system (*.tgz) 

640-011-001-004 640-011-001-005 

Applications (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

 

Notes for Table 4 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 5: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system (*.tgz) 

640-003-001-016 

Applications (*.tgz) 

640-010-001-016 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 



 

Document reference VIBROSIGHT-RN/E (660-010-013-232A) 
Version 32A – 06.07.2021 

RELEASE NOTES 
VibroSight® 6.1.0 

59 / 71 
 

Table 6: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-009 642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 

3.4.0 
609-004-000-041 

 See note 2 
See notes 

2 and 3 
 

  

3.5.0 
609-004-000-042 

   
  

3.6.0 
609-004-000-043 

   
  

3.7.0 
609-004-000-044 

   
  

3.8.0 
609-004-000-045 

   
  

4.0.0 
609-004-000-046 

   
  

4.1.0 
609-004-000-047 

   
  

5.0.0 
609-004-000-048 

  
See notes 

2 and 4 

See notes 

2 and 5 
 

5.1.0 
609-004-000-049 

     

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
See notes 

2 and 6 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 
 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

6. For information on this version of VibroSmart VSI010 firmware, see 2.6 VSI010 + VSB010 module. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later.  
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Table 7: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 8: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-016 642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 

3.4.0 
609-004-000-041 

See notes 

2 and 4 

    

3.5.0 
609-004-000-042 

 
    

3.6.0 
609-004-000-043 

 
    

3.7.0 
609-004-000-044 

 
    

3.8.0 
609-004-000-045 

 
    

4.0.0 
609-004-000-046 

 
    

4.1.0 
609-004-000-047 

 
    

5.0.0 
609-004-000-048 

 
See notes 

2 and 5 

See notes 

2 and 6 

  

5.1.0 
609-004-000-049 

   
See notes 

2 and 7 
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
See notes 

2 and 8 

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for hydro air-gap monitoring. 
A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 
 

4. This version of VibroSmart VSV30x firmware adds support for latched alarms. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 
 

5. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

6. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

7. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 
 

8. For information on this version of VibroSmart VSV30x firmware, see 2.5 VSV30x + VSB300 module. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later.  
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to incoherent system 
behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where the firmware 
running on the XMx16 cards and VibroSmart devices already corresponds to the latest available version that no 
firmware update is required. Therefore, it is strongly recommended to verify the version of firmware running on the 
hardware before starting a VibroSight system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600 card or VibroSmart device 
selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware (VM600 cards 
and /or VibroSmart modules) have been discovered and that data acquisition has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows operating system compatibility 

 

 
Windows 10 Windows 8.1 Windows 7 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows 7 ended in 

January 2020) 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 
Windows Server 2016 Windows Server 2012 Windows Server 2008 R2 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows Server 2008 R2 ended in 

January 2020) 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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